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Introduction
The Dallas Semiconductor TMEX Runtime Environment is a set of software drivers
and utility programs to interface with the Dallas Semiconductor iButton products
(Touch Memories) and other 1-Wire devices including sensors.  iButtons are high-
capacity, general-purpose electronic data carriers, each with a unique registration
number acting as a general identification number and a unique network node
address. Communication with iButtons and 1-Wire devices is done over a single
data line plus ground reference using the 1-Wire protocol.  This network is called a
1-Wire Net or “MicroLAN”.

The drivers enable TMEX-ready 1-Wire applications to run. The TMEX Runtime
Environment, referred to simply as TMEX, supports Microsoft Windows 95/98/Me,
Windows NT 4.0, and Windows 2000 on standard desktop and laptop computers.

The TMEX Runtime Environment can be used
a) stand alone with the provided utilities
b) in conjunction with other Dallas Semiconductor TMEX-based kits
c) with third party applications that require TMEX.

Dallas Semiconductor offers the 1-Wire Software Developer’s Kit (SDK) for Windows
(part number DS0621-SDK), to develop applications for this runtime environment.
This SDK was formerly known as the iButton-TMEX Software Developer’s Kit.  The
SDK supports all of the platforms provided in the TMEX Runtime Environment.  It
includes multiple source code examples in several languages including C, Pascal
and VB.  It also includes the full documentation of the TMEX API.
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Overview
The following section of this document describes the installation of the 1-Wire drivers
under Windows 95, Windows 98, Windows Me, Windows NT 4.0, and Windows
2000. The TMEX Runtime Environment installs the TMEX API drivers and all the
associated interface DLLs accompanying them.  In addition, subsequent sections of
this document describe the default 1-Wire Port, and the use of the iButton Viewer
software application.  Different 1-Wire adapters are available to be used to
communicate with 1-Wire devices, including ones for serial ports, parallel ports, and
USB ports.  The iButton Viewer uses these ports and combines the features of
multiple 1-Wire software utilities in a single software program.  The iButton Viewer
supports a multi-drop environment where multiple iButtons may reside on the 1-Wire
bus and are accessed independently of each other.



TMEX Runtime Environment

110701 6/90

 Installation
Before upgrading to this version of TMEX Runtime Environment (formerly referred to
as Single User License ‘SUL’) always remove any previous version with its
uninstaller.  The uninstall program can be accessed with the ‘Add/Remove Software’
utility in Windows (discussed below).

1. Click on the 'Start' button
2. Click on 'Settings' and then 'Control Panel'
3. Double-click on the 'Add/Remove Programs' icon in the 'Control Panel'
4. Select the 'iButton-TMEX (32-Bit) VX.XX' line in the 'Add/Remove

Programs' window (where X.XX is the old version number)
5. Click OK at the bottom of the 'Add/Remove Programs' window
6. When asked if you want to remove all of iButton-TMEX, click OK.

The installation of TMEX Runtime Environment for 32-Bit Windows is a standard
wizard format install program.  This install program can come in various formats:

1. Menu option from a CD install program
2. Floppy with a SETUP.EXE program
3. Downloaded from Dallas Semiconductor’s Web site.

(http://www.ibutton.com).

In each case, once the install begins it will look the same.  If the install does not
automatically start then double click on the ‘SETUP.EXE’ or ‘TM320_32.EXE’ self-
extracting install program using ‘Windows Explorer’.

Details on the files that are copied to the system during the install can be found in
Appendix B.

Please note that there are multiple installation distributions available.  Two
distributions are available that contain the iButton Viewer, along with the TMEX API
drivers.  Three distributions contain the TMEX API drivers only.  All of them are
available for download from http://www.ibutton.com/software/tmex.

Of the two installation distributions that include the iButton Viewer, one of them is a
self-extracting executable.  This can be simply downloaded and run (by double-
clicking).  The second installation distribution is available as an archive of two
tar/zipped diskettes.  The archive will need to be unzipped, and then the contents
can either be copied onto diskettes, and run from there (by double-clicking the
SETUP.EXE file on the first diskette), or just unzipped to a specified folder and run.

The second group of installation distributions is the drivers-only group.  Three
distributions are available for a drivers-only installation.  Similar to the installation
distributions mentioned above, the first one is a self-extracting executable, and the
second is an archive of two tar/zipped diskettes.  They function identically to the
installations above except that the iButton Viewer is not installed.  Thirdly, an

http://www.ibutton.com
http://www.ibutton.com/software/tmex
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installation distribution exists as one tar/zipped archive.  It contains all the driver files
for a manual two-diskette installation in one folder.

Initial Screens
Before installing the Windows 32-Bit version of the TMEX Runtime Environment,
connect a 1-Wire adapter to the PC.  See Appendix A for a description of available
adapters from Dallas Semiconductor and third party suppliers.  Close any open
application before starting the installation.

Start the installation as described above (i.e. SETUP.EXE …).  The first screen that
is returned from the installation program asks the user whether or not to proceed
with the installation of TMEX.  See picture below.

If the user selects to continue with the TMEX installation by clicking “Yes”, then after
the installation program completely loads, a USB warning screen appears,
prompting the user to unplug any 1-Wire USB device plugged into the computer if
the user wants the USB driver to be updated.

After the above screen is presented, several other screens will follow.  During the
installation you can move from screen to screen by clicking on the button “Next >“ or
“< Back” or cancel the installation (“Cancel”).

License Agreement
Right after the initial screens, the Software License Agreement is displayed. The
license agreement can be scrolled through on screen or, after the installation is
completed, be printed (LICENSE.TXT). The next screen provides general informa-
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tion on the TMEX Runtime Environment and a reminder to uninstall any earlier
revision of the program before proceeding with this installation.

Readme Information
In one of the subsequent screens, the user is displayed the contents of the primary
readme.txt file.  It covers the installation process and some of the major points
contained in this document.  It is also available as a text file after the installation
completes.

Destination Location
In the next step the installer asks for the Destination Location where the program
files are to be copied. The default location is on the Windows drive in the \Program
Files \Dallas Semiconductor\iButton-TMEX (32-Bit) V3.20\ directory. You may enter
any other destination directory using standard conventions. If the directory does not
yet exist it will be created. You may instead click on “Browse...” and select an
existing directory.

Program Folder
Windows allows programs to be grouped into “Program Folders”. If you accept the
default shown on the Select Program Folder screen, the installer will create a new
program folder “iButton-TMEX” with the icons for the iButton Viewer {32 Bit}, iButton-
TMEX ReadMe {32-Bit}, the iButton Viewer Help {32-Bit} , and the Default 1-Wire
Net Port {32-Bit} utility.  Alternatively you may create a new folder by typing its name
or select an existing folder by scrolling through the list of folders.

1-Wire Net Port Selection
After the Program Folder has been selected, one has to specify which of the ports
with a 1-Wire adapter connected is to be defined as the TMEX default 1-Wire Net
port. This is done through the Port Selection Screen. It is possible to have more than
one port adapter plugged in at a time. However, only one of them can be selected as
the default.



TMEX Runtime Environment

110701 9/90

On the Port Selection Screen, select the tab of the hardware adapter that is to be
used.  Next enter the port number where the 1-Wire adapter was attached during the
preparation of the installation (see Initial Screens). After a port with adapter has
been selected, the port number, adapter type and driver information will be
displayed, and the user can proceed to the next screen. If a port with no adapter
connected is selected, you will get an error message.  Alternately the ‘Auto-Detect’
button can be clicked to search through all port types.

Setup Complete
When you reach this screen, the TMEX installation is completed.  Re-booting is not
required.
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Notes
After TMEX is installed, the iButton Viewer and other TMEX-dependent programs
(not included in the TMEX install) can be used without having to run the installer
again. If you change the 1-Wire port on your computer, however, the application
software such as the viewer needs to be reconfigured. The iButton Viewer has a
function to do this (see next section for details), but it does not change the TMEX
default 1-Wire port in the registry.  To change your default port use the ‘Default 1-
Wire Net Port’ as described in the next section.
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Default 1-Wire Net Port
TMEX applications will use the ‘Default 1-Wire Net’ port on their first invocation.
Some of these applications such as the iButton Viewer will then allow you to change
the 1-Wire Net port it uses.  This will not change the default port.  Applications
without a means to select a port will use the ‘Default 1-Wire Net’ port exclusively.  To
change the ‘Default 1-Wire Net’ port after installation, run the ‘Default 1-Wire Net
Port {32-Bit}’ icon in the iButton-TMEX folder.  This will run the application
SETPRT32.EXE.
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iButton Viewer

Introduction
The iButton Viewer is a Windows program for communicating with iButtons and
other 1-Wire Net compatible 1-Wire devices. The iButton Viewer supports a true
network environment. Device-specific viewers allow evaluation of special function
devices.

The main features of the iButton Viewer are:

•  Supports 1-Wire Net environment with no logical limit for the number of
devices on the bus

•  Reads and writes Memory iButtons based on SRAM, EPROM and EEPROM
technology

•  Supports all currently available iButtons and their solder-mount equivalents

•  Thermochron (temperature recorder) viewer for the DS1921

•  A/D viewer for the DS2450 quad A/D device

•  DS2438 Viewer supports A/D voltage readings, temperature, and relative
humidity measurements (for the DS1910 Hygro iButton) (new for V3.20)

•  Counter viewer for DS2423 and DS2422

•  DS2890 1-Wire Potentiometer viewer (new for V3.20)

•  Sophisticated 1-Wire File Structure viewer for DS1973 (DS2433), DS1963L,
DS1963S, DS1982 (DS2502), DS1985 (DS2505), DS1986 (DS2506),
DS1992, DS1993, DS1994 (DS2404), DS1995, DS1996, DS2406, and
DS1921 with upload/download from PC to iButton and iButton to clip board

•  Time register viewer for DS1994 (DS2404)

•  Secure viewer for DS1991

•  EEPROM viewer for DS1971 (DS2430)

•  Temperature viewer for DS1920 (DS18S20)

•  Switch viewer for DS2406, DS2409

•  Serial Number Viewer for DS1990 (DS2401A) and device types currently
without a dedicated viewer

•  Debug ‘raw’ viewer for (DS2430A), DS1973 (DS2433), DS1963L, DS1963S,
DS1982 (DS2502), DS1985 (DS2505), DS1986 (DS2506), DS1992,
DS1993, DS1994 (DS2404), DS1995, DS1996, DS2406, and DS1921.
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•  Multiple window, multiple port operation to view several devices
simultaneously

•  Supports Overdrive communication

•  Context sensitive help

The iButton Viewer accepts generic as well as custom ROM devices. For devices
currently under development the iButton Viewer will, in most cases, display the part
number together with a short description. As soon as these devices become gener-
ally available, the iButton Viewer will be revised to include the necessary viewers.
Until then a message “This device type is not currently supported by this version of
the iButton Viewer.” will be displayed. The iButton Viewer is able to read the ROM
Registration Numbers of future 1-Wire Net-compatible 1-Wire device types but it will
be unable to provide a description or Dallas Semiconductor part number.



TMEX Runtime Environment

110701 14/90

Main Screen
The iButton Viewer is launched like other Windows program by double-clicking on its
icon in the ‘iButton-TMEX’ folder. The main screen of this program (see marked
sample below) consists of several sections, each with its special purpose. These
sections are: Network Listbox (left), Part Number drop-down Combobox (top),
Viewer Launching Button (lower right), Menu Bar (top) and the Status Bar (bottom).

The Network Listbox is the primary switchboard of the iButton Viewer. It lists the
ROM codes (= network node addresses) of all devices currently connected to the 1-
Wire network. The user can scroll through this list with the cursor keys or click on a
network node address to select a device. Depending on the number of devices
connected, the Network Listbox may have a scroll bar to allow reading all addresses
and selecting a device. If no device is connected the Network Listbox will be empty.

Network
Listbox

Part Number
drop-down
Combobox

Status Bar

Viewer
Launching
Button
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After a device has been selected in the Network Listbox, its node address is high-
lighted and its part number appears in the Part Number Combobox. The area be-
low the Part Number Combobox will then display some of the device’s characteris-
tics. The Part Number Combobox also may be used independently of the population
of the 1-Wire network. Clicking on the down arrow at the right of the Combobox will
display the list of devices that are recognized by the program. An optional scroll bar
allows reading the entire list. Clicking on a part number will close the box and display
the device description. If there is a device with the selected part number on the 1-
Wire bus, it will automatically be selected.

The next step after selecting a device is launching a device viewer. There are cur-
rently eleven device viewers implemented in the program. The family code of the
device (i. e., the two least significant digits of the node address as displayed in the
Network Listbox) determines which viewer applies. Usually the iButton Viewer
selects the device viewer automatically. For some devices (such as the DS1994)
there may be more than one viewer. In such a case the program will display the
names of the applicable device viewers and ask the user to select one when trying
to launch the device viewer.

There are several ways to launch a device viewer: a) clicking on the Viewer
Launching Button, b) double-clicking on a network node address shown in the
Network Listbox or c) pressing the right mouse button. Method a) is the direct one.
Method b) combines device selection with launching the device viewer. Method c)
displays a three-item Listbox next to the cursor where one then has to click on
“Viewer”. Regardless of the method, a viewer window will pop up that is associated
only to the individual device that has selected. The individual device viewers are de-
scribed in detail on the subsequent pages.

The iButton Viewer Main Screen has two more sections: Menu Bar and Status Bar.
The Menu Bar has three entries: File, Options and Help. File opens a path to exit
the iButton Viewer program, which is equivalent to closing the iButton Viewer’s win-
dow. Help launches the Windows Help Utility to access the program-specific help
file. Selecting ‘About’ under help shows the user the version of the iButton Viewer as
well as the versions of the underlying TMEX Runtime Environment drivers.

Options opens a list with six items: a function “1-Wire Net Port” to dynamically
change the 1-Wire Port that is monitored by the iButton Viewer and four individual
flags “Auto Viewer Start”, “Auto Viewer Close”, “Auto Save Size/Position”, “File Auto
Overdrive”, “Set Flex Speed”, and “Debug Enable”. The function “1-Wire Net Port” is
similar to the port selection scheme used during the TMEX installation. However, the
port selected with “1-Wire Net Port” is valid for the iButton Viewer only. It does not
alter the default selection made during the TMEX installation. The Status Bar shows
the currently valid port name at its left side for verification.

The “Auto Save Size/Position” flag, if checked, will force the iButton Viewer to pop
up always in the same window size and position it had when it was last used. The
port selection function as well as the exit path is also accessible through the right
mouse button. More details on port selection and a full discussion of the four option
flags are found in the section “Viewer Customization/Advanced Features.
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Just below the entry “File” in the menu bar there is a blinking spot labeled 1-Wire
Net Activity. Whenever this spot is green it indicates that 1-Wire Net communication
such as ROM Search (see device data sheets) is in progress. An activity indicator is
also found on each device viewer window. This indicator is green whenever the
associated device viewer is accessing and in control of the 1-Wire Net.
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Thermochron (temperature recorder) Viewer
The Thermochron (temperature recorder) Viewer is a tool to initialize and download
the temperature data from a DS1921 Thermochron iButton.

Initializing the DS1921 is referred to as sending it on a ‘mission’.  There are several
options when starting a mission.  To go through each of these options, the
Thermochron viewer incorporates a ‘Mission Wizard’.  If the device is not currently
on a mission, then the Thermochron viewer defaults to display the wizard first.

The viewer has two other main tabs: ‘Mission Results’ and ‘Status’.  ‘Status’ will
display the current settings in the DS1921 such as if a mission is in progress, the
number temperature readings taken, etc.  The ‘Mission Results’ will contain the log
of temperature readings and histogram.  The bottom of the viewer contains a status
message describing the current operation being performed.

If ‘Auto Save Size/Position’ is checked in the main iButton Viewer options, then the
state of the Thermochron Viewer is saved and restored on the next invocation.  This
includes the size, position of the window, choices in the mission wizard, and display
options.

Menu Options
There are several menu options available.  They can be accessed by clicking on the
menu groups at the top of the viewer.

     

File / Copy Export Data to Clipboard
The Copy Export menu option will take mission status and results and copy it to the
Windows clipboard in the form of text.  This may be more convenient than saving the
data to a text file before importing it into another program.

File / Exit
The Exit menu option will close this viewer and any open quick graphs.
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Options / Fahrenheit and Celsius
The temperature mode options select whether all of the temperatures in this viewer
are displayed as Fahrenheit or Celsius.  Click on the desired format.  This format will
also be used in all graphs and export data.

Options / Show F/C on Temperatures
The Show F/C option toggles whether the temperatures displayed throughout the
viewer have the F or C appended to indicate the temperature display mode.  It is
sometimes desirable to not have the letter displayed for easier import into other
applications.

Options / Automatic Export Prompt
When checked, the ‘automatic export prompt’ will automatically prompt for an output
text file immediately after the mission data has been downloaded.  This could be
used in combination with the iButton Viewer’s ‘Auto Viewer Start’ and ‘Auto Viewer
Close’ options to quickly download the results of Thermochron missions.

Options / Debug Dump in Export File
When checked, the ‘Debug Dump’ option will automatically copy the raw dump of the
DS1921 memory pages into the export file or clipboard.

Options / Stop Current Mission
The ‘Stop Current Mission’ menu option will end a mission if one is currently in
progress.  It does not, however, stop the real-time clock.
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‘Mission’ Wizard
The Mission Wizard can be started at any time by clicking on the ‘Wizard’ tab and
proceeding through the options by clicking on ‘NEXT >’ button.  At any time,
previous options can be re-addressed by clicking on the ‘< BACK’ button.
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Real-Time Clock Set
The next Wizard screen will optionally set the DS1921’s real-time clock from the PC
clock.  To help with this decision, the current device and PC clock time is displayed.
The time display will be updated approximately every 3 seconds.  The time is
displayed in 24-Hour format. Clicking on the check box at the bottom will toggle
whether the time will be set from the PC.
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Time Alarm
The time alarm will select the time at which the DS1921 will start responding to a
conditional search.  The conditional search is a way to service only the device’s that
need attention in a multi-device network.  The alarm can occur weekly, daily, hourly,
minutely, or every second.  The top drop-down box will select the mode.  The lower
drop-down boxes will select the relevant times.  Some of the lower drop-down boxes
will not be visible in some alarm modes.  For example the ‘Day’ drop-down will not
be visible when alarming hourly.  The bottom check-box selects whether the device
will respond to a conditional search when a Time alarm has occurred.  Since the
Time alarm cannot be disabled, selecting the alarm mode of ‘none’ will set a
‘Weekly’ alarm.  The check-box at the bottom selects whether the device responds
to a conditional search when a Time alarm occurs.
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Mission Start Delay
The DS1921 can delay a specified number of minutes before it begins taking
temperature readings.  This feature can be used to prevent needless readings
before the target time frame or to space several DS1921’s at staggered intervals.
As a convenience, drop-down boxes are used to select a number of days, hours,
and minutes.  The total minutes delay is displayed.  The DS1921 has a maximum
start delay of 65536 minutes or about 45.5 days.  The drop-down boxes allow a
maximum selection of 44 days, 23 hours, and 59 minutes giving a total of 64799
minutes.
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Sample Rate
The Sample Rate specifies the number of minutes between each temperature
reading.  The DS1921 can store 2048 time stamped temperature readings.  Setting
the sample rate will affect how long it takes for the memory to fill up or optionally roll
over.  The sampling rate can be from 1 to 255 minutes.
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Temperature Alarms
Certain temperature extreme readings can be tracked by the DS1921 even after the
2048 time-stamped temperature readings have already been done.  The start and
duration of the violation of temperature bounds is recorded.  The maximum duration
for each event is 255 readings.  The device can accommodate 12 separate high
events and 12 low events. The check box at the bottom selects whether device
responds to a conditional search when a High or Low temperature alarm occurs.
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 Roll-Over
There is a maximum of 2048 time-stamped temperature readings.  This Wizard
panel indicates the amount of time it will take to fill up this memory, depending on
the sample rate.  The behavior of the DS1921 can optionally be set to begin
overwriting the early readings when the memory is filled.  If this sample period is too
small, use the ‘< BACK’ button to go back to the sample rate selection and pick
slower sample rate.  Note that any readings beyond 2048 are still recorded in the
histogram data.
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Finish
The final panel of the Wizard displays all of the options selected.  If any of these
settings is not desired, use the ‘< BACK’ button to revisit the different options.  The
box at the bottom of the panel may not be able to display all of the options.  Use the
scroll bar to view all of the options.  When satisfied, click on the ‘FINISH’ button.
The mission settings will then be written to the DS1921 and the mission will begin.
To show the state of the new mission, the viewer will automatically switch to the
‘STATUS’ tab.
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Status Display
The Status Tab displays the current DS1921 status.

Mission Status
The Mission Status will indicate ‘in progress’ if a mission is currently running.  It will
display ‘ended’ if there is no mission.

Mission Start
The Mission Start is the date/time stamp of the beginning of temperature readings.
Note that this is the start time after the start delay has expired and the first reading
has been taken.  While the start delay is counting down the Mission Start will be
displayed as ‘not started yet’.  The mission start is displayed in 24-hour format.

Sample rate (minutes)
The Sample Rate is the number of minutes between samples.

Start Delay (minutes)
The Start Delay is the current delay count down value in minutes.  For example, if in
the mission Wizard a start delay of 10 was selected, then the initial value viewed in
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this box would be 10.  After a minute it would decrement to 9 and then to 8 and so
on.  When the start delay goes to 0, then the mission sampling will begin.

Roll-Over Enabled
Roll-Over Enabled will say ‘yes’ if the device has been missioned to overwrite early
readings after the 2048 time-stamped readings have been done.  It will say ‘no’ if roll
over is not enabled.

Mission Samples
The Mission Samples indicates the number of temperature samples that have been
taken during the current mission.

Roll-Over Occurred
Roll-Over Occurred will say ‘n/a’ for not-applicable if roll-over is not enabled.  If roll-
over is enabled, then this box will display ‘yes’ if more then 2048 readings have been
made, or ‘no’ if the number of readings is less then 2048.

Total Samples
Total Samples indicates the total number of temperature samples that have been
taken on the device.

Force Read
If there is no current mission, the Force Read button is enabled.  Clicking this button
instructs the DS1921 to read the current temperature.  The temperature will be
displayed to the right of the button after a few seconds.  The Force Read button is
disabled if a mission is currently running.

High Threshold
High Threshold indicates the upper bound temperature maximum.  If during a
mission the temperature reading goes above this value, an alarm event will occur
and the time and duration of this event will be recorded.

Low Threshold
Low Threshold indicates the lower bound temperature minimum.  If during a mission
the temperature reading goes below this value, an alarm event will occur and the
time and duration of this event will be recorded.

Temperature Threshold Status
The Temperature Status below the ‘Low Threshold’ will indicate the settings and the
state of the temperature threshold violations.  There are two parts to the statement:
‘Conditional’ and ‘Alarm’.  The ‘Conditional’ part indicates the settings for the device
to respond to a conditional search on an alarm condition.  A value of (H,L) indicates
both High and Low thresholds will enable a conditional search response.  ‘H’
indicates High threshold is used and ‘L’ the Low threshold.  ‘none’ indicates that
neither of the thresholds will cause a response to a conditional search.  In the same
manner, the ‘Alarm (H,L)’ indicates if there is currently an alarm condition with either
threshold.
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Time
Time displays the current real-time-clock value from the DS1921.  This value is
updated every 3 seconds, except during the download of the mission results.  It is
displayed in 24-hour format.

Alarm Mode
The Alarm Mode indicates the period at which the time alarm can occur.  The
possible alarm modes are: ‘Alarm weekly’, ‘Alarm daily’, ‘Alarm hourly’, ‘Alarm
minutely’, and ‘Alarm every second’.  If no alarm mode was selected in the Wizard
then the default mode is ‘Alarm weekly’.

Alarm Time
The Alarm Time will indicate the relevant time in the alarm mode when the time
alarm will occur.  The format of this will depend on the alarm mode.

Alarm Time Status
The Alarm Time Status below the ‘Alarm Time’ will indicate the settings and the state
of the conditional search on a time alarm.  There are two parts to the statement:
‘Conditional’ and ‘Alarm’.  The ‘Conditional’ part indicates the settings for the device
to respond to a conditional search on an alarm condition.  A value of (yes) indicates
the device will respond to a conditional search on an alarm event.  (no) indicates that
it will not respond to a conditional search. In the same manner, the ‘Alarm (yes)’ part
indicates in the same format if there is currently a time alarm condition.



TMEX Runtime Environment

110701 30/90

Mission Results
The Mission Results tab displays the temperature reading results from the current or
last mission.  The mission results are automatically downloaded when the
Thermochron Viewer is started if there is a mission running.  If the mission has been
ended, then results can still be downloaded using the ‘Read Data’ button.  The
‘Read Data’ button can also be used to refresh the result contents if the device has
been connected long enough for a mission reading to take place.

View Options
The View Options modify how the temperature reading results are displayed.  The
‘Alarms/Log’ radio control selects displaying a true time/data or a minute offset from
the beginning of the mission.  This option affects the Log and Temperature alarms
results.  The ‘Histogram’ radio control selects the histogram display options.  The
‘Range’ option shows a temperature range for each bin in the histogram.  ‘Start Only’
displays only the starting value for each bin.  ‘Bin Number’ displays a number 0 to 55
to indicate the bin number.  Finally, the ‘Data Delimiters’ radio control selects what
character (comma or semicolon) is used to delimit the information in the Lot,
Temperature Alarms, and Histogram display areas.  It is also used to delimit the data
when exporting the results.  The View options will be used in the export file and
quick graphs.
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The ‘Export Results’ button prompts for a text file to export all of the mission results
and status.  Note that there is a menu option to copy the same contents to the
clipboard.

The ‘Read Data’ button will force the viewer to re-read the mission results.  This can
be used to refresh the result data if a mission is currently running and it has made
new measurements.

Log
The Log displays the time-stamped temperature readings in a Listbox.  The format
for the entries is displayed above the Listbox (see View Options).   The ‘Quick
Graph’ button in the Log box will display a quick line graph of the data collected.
The line graph is color coded to indicate values above (red) or below (blue) the
temperature thresholds.  For more sophisticated graphs it is recommended to use
the data export features to import the data into another application with advanced
graphing capabilities.

Temperature Alarms
The Temperature Alarms box displays the temperature alarm events.  An alarm
event is created when the temperature read during a mission goes outside the
specified thresholds.  There can be up to 12 high and 12 low alarm events.  Each
event lists the event type (High, Low) and the start and end time.  A time/date stamp
or minute offset will represent the time range depending on the view options.



TMEX Runtime Environment

110701 32/90

 Histogram
The Histogram box displays the temperature history as defined by 56 bins.  Each bin
represents a temperature range.  When a temperature reading is made, the
associated bin in incremented.  Each bin can hold up to 65536 readings.  The 56
bins are listed in a Listbox in the format specified by the view options.  The ‘Quick
Graph’ button displays the bar graph of the histogram data.  The labels on the bar
graph are in the format specified by the view options.
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A to D Viewer
The Analog to Digital viewer displays the results and allows manipulation of the
settings for the DS2450 low power 1-Wire quad A/D.  All four of the channel results
can be viewed at the same time as seen in the screen capture below.

The center box has four smaller boxes representing each of the four A/D channels.

The bottom box has logging and plotting options and data.

If ‘Auto Save Size/Position’ is checked in the main iButton Viewer options, then all of
the state of the A to D Viewer is saved and restored on the next invocation for each
DS2450 device.  This includes the size, position of the window, settings for each
channel and sample rate.
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Sample Rate
The drop down box at the top selects the sample rate.  The sample rate can be from
1 to 32 seconds.  Due to Window’s multitasking, the sample rate is approximate.
The sample rate drop down box can also select ‘STOP’ which disables reading the
channels.

Sound on each Read
The check box at the top right of the main window selects whether a sound is played
when a new reading is made.

Menu Options
There are several menu options available.  They can be accessed by clicking on the
menu groups at the top of the viewer.

    

File / Copy Log to Clipboard
The Copy Log menu option will take the current log data as seen in the log Listbox
and copy it to the Windows clipboard in the form of text.  Note that the log also
contains the setup information for each of the channels.  This may be more
convenient than saving the log to a text file before importing it into another program.

File / Exit
The Exit menu option will close this viewer and any plot this viewer opened.

Debug / Raw page dump into log
The Raw Page Dump menu option will place a copy of the current memory pages of
the DS2450 into the log.

Channel Results
Each of the four channels has its own display with two tabs as seen in the following
cutout from the A to D viewer.  The tabs are ‘Result’ and ‘Setup’.  The ‘Result’ tab
displays the current readings from the channel.
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Channel Enable Check
The check-box outside the tab structure enables or disables the channel.  Notice in
the above cutout, Channel C is enabled but Channel D is not.

Voltage Out and Alarm Flags
The top label in the ‘Result’ tab shows the current voltage measured on the Channel.
The number of significant digits in the voltage displayed changes to reflect the
accuracy provided by the selected number of bits used to make the conversion.  To
the left of the voltage a small red ‘H’ can be seen.  This indicates that the current
value has exceeded the high trip threshold.  A small blue ‘L’ would appear to the
right of the voltage if the voltage went below the low trip threshold.

Log Select
The check mark bellow the voltage selects whether the voltage is logged to the list
box at the bottom of the window.

Output Control
Each channel can optionally be used as an open drain output.  The ‘Output Control’
selects the output state of the channel.  ‘NONE’ indicates that the channel is uses as
an input.  ‘1’ indicates that the channel is an output letting the channel float to high.
A ‘0’ value indicates that the channel is being pulled to ground.

Channel Setup
The ‘Setup’ tab displays the current settings for the channel and allows changes by
utilizing the drop-down Listbox.
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Scale
The scale indicates the highest possible voltage value that is read by the channel.
The two choices are 5.10 Volts and 2.55 Volts.  Selecting the lowest range required
gives a higher measurement granularity for a given bit resolution.

Bit Resolution
The bit resolution indicates the number of bits in the conversion result.  The range is
1 to 16 bits.  Changing the bit resolution changes the available Low and High trip
values.

Trip Low
The trip low is the low voltage threshold.  A low threshold alarm is set when the
voltage read goes below this value.

Trip High
The trip high is the high voltage threshold.  A high threshold alarm is set when the
voltage read goes below this value.

Logging
The logging box is at the bottom of the A to D Viewer window.  The right side of the
logging box contains a Listbox with the updated log.

Log Data
The log consists of a time stamp followed by each channel’s value read delimited by
commas.  If a channel is not enabled or logging is not selected then there is no value
between the commas.  For example the log data line of ‘2:23:59 PM, 1.01, 2.23, ,
4.55’ shows the time-stamp, channel A data, channel B data, (no data for channel
C), and channel D data.

Save
Clicking the Save button prompts the user to enter a text file to save the log data
delete to.

Clear
Clicking the clear button will clear the current log data.
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Plot
The plot combo box provides a choice on which if any channel will be plotted.  The
plot is an auto-ranging line graph of the last 100 readings.  The plot is color coded to
indicate readings outside the high (red) and low (blue) trip values for the selected
channel.
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Sensor Viewer
The Sensor Viewer displays the results and allows manipulation of the settings for
the DS2438 as it pertains to sensors.  Temperature, VDD (voltage supply), and VAD
(output voltage) can be viewed at the same time as seen in the screen capture
below.  These three measurements that the DS2438 takes, allow it to be used as a
sensor.  The actual sensor data can be calculated from the three different
measurements.  Currently, a DS2438-based relative humidity sensor is supported.
Also displayed in the viewer is a fourth measurement, Vsens, which is a measure of
the instantaneous voltage across the DS2438’s Vsens pins.  With a photodiode, this
can be used as a light detector/sensor.

The center region of the main sensor viewer window has five distinct areas
representing each of the above measurements plus the actual sensor calculation.
The bottom box has logging and plotting options and data.

If ‘Auto Save Size/Position’ is checked in the main iButton Viewer options, then all of
the state of the Sensor Viewer is saved and restored on the next invocation for each
DS2438 device.  This includes the size, position of the window, settings for each
measurement and sample rate.

Sample Rate
The drop down box at the top selects the sample rate.  The sample rate can be from
2 to 32 seconds with an additional rate of ‘continuous’.  ‘Continuous’ means with no
delay between sample reads.  Due to Window’s multitasking, the sample rate is
approximate.  ‘STOP’ is another selection of the drop down box.  With ‘STOP’
selected, reading of the different measurements taken by the DS2438 is disabled.

Sound on each Read
The check box at the top right of the main window selects whether a sound is played
when a new reading is taken.
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Menu Options
There are several menu options available.  They can be accessed by clicking on the
menu groups at the top of the viewer.
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File / Copy Log to Clipboard
The Copy Log menu option will take the current log data as seen in the log Listbox
and copy it to the Windows clipboard in the form of text.  Note that the log also
contains the setup information for each of the DS2438 measurments.  This may be
more convenient than saving the log to a text file before importing it into another
program.

File / Exit
The Exit menu option will close this viewer and any plot this viewer opened.

Logging / Log Temperature
The check mark on the left side of the ‘Log Temperature’ menu item selects whether
the temperature is logged to the list box at the bottom of the window.

Logging / Log VDD
The check mark on the left side of the ‘Log VDD’ menu item selects whether the
VDD voltage is logged to the list box at the bottom of the window.

Logging / Log VAD
The check mark on the left side of the ‘Log VAD’ menu item selects whether the
VAD voltage is logged to the list box at the bottom of the window.

Logging / Log Vsens
The check mark on the left side of the ‘Log Vsens’ menu item selects whether the
Vsens voltage is logged to the list box at the bottom of the window.

Logging / Log Sensor
The check mark on the left side of the ‘Log Sensor’ menu item selects whether the
Sensor data is logged to the list box at the bottom of the window.

Display Areas
Each of the four DS2438 measurements has its own display area of the viewer
window.  The fifth area represents the calculated sensor data.  Each display area
has a checkbox associated with it that enables the display area when checked and
disables it when unchecked.  See the pictures below for examples.
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The above images show the temperature display area enabled and disabled.
Please note the radio buttons that will allow changing between Celsius and
Fahrenheit temperature scales.

The above six images show the VDD, VAD, and Vsens voltage display areas
(respectively) enabled and disabled.
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The two images above show the sensor display areas enabled and disabled.  If
enabled and three other display areas (Temperature, VDD, and VAD) are not, they
will automatically be enabled (because calculating sensor data requires
Temperature, VDD, and VAD to be enabled).  Likewise, if one of the three areas is
disabled, the sensor display area will also become disabled.

Logging
The logging box is at the bottom of the Sensor Viewer window.  The right side of the
logging box contains a Listbox with the updated log.

Log Data
The log consists of a time stamp followed by each DS2438’s measurement delimited
by commas.  If a display area is not enabled or logging is not selected then there is
no measurement between the commas.  For example, the sample log data line
highlighted in the picture below shows the data to be “5:40:30
PM,23.0,4.79,2.51,0.2,58.”  This shows the data for every channel.  However, if VDD
and Vsens were disabled, the line would have been:  “5:40:30 PM,23.0,,2.51,, ”
showing the time-stamp, temperature, no data for VDD, VAD voltage, no Vsens
data, and no sensor data.

Save
Clicking the Save button prompts the user to enter a text file in which to save the log
data.  It also prompts the user to clear the log listbox.

Clear
Clicking the clear button will clear the current log data.

Plot
The plot combo box provides a choice on which, if any, DS2438 measurement will
be plotted.  The plot is an auto-ranging line graph of the last 100 readings.
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Digital Potentiometer Viewer
The Digital Potentiometer Viewer displays the results and allows manipulation of the
DS2890.  The DS2890 is a single element, 256-position linear taper potentiometer
with terminal working voltages up to 11V and a 100 KiloOhm resistor element value.
It can be powered either parasitically or through an external power supply.
Potentiometer wiper positions can be set and read through this viewer, along with
setting a Charge Pump for greater sensitivity (only for externally powered
potentiometers).

As with the other viewers, if ‘Auto Save Size/Position’ is checked in the main iButton
Viewer options, then all of the state of the Digital Potentiometer Viewer is saved and
restored on the next invocation for each DS2890 device.  This includes the size and
position of the window settings.

The viewer has three distinct sections: the top, middle, and bottom sections.  They
allow for both reading and setting a DS2890.
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Top Section
The top section of the viewer displays the current wiper setting of the potentiometer.
A valid setting is from 0 to 255.  See the image below:

Middle Section
The middle section of the viewer allows the user to increment or decrement the
wiper value through clicking the right or left arrows respectively.  It also allows the
user to either step the wiper positions (in increments of 1) to the maximum setting
(255) or to the minimum setting (0) through clicking on the appropriate buttons.  See
the image below:

Bottom Section
The bottom section of the viewer allows the user to set the wiper value directly
through inputting a number in the edit box and then clicking the “Set Wiper” button.
It also contains an option to turn the “Charge Pump” on or off by clicking on the
appropriate radio box.  If it is not possible to turn the Charge Pump setting on, the
viewer will respond with an appropriate message telling the user that it could not.
See the image below:
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Counter Viewer
The Counter Viewer displays and calculates rate (counts per second) for iButtons
that incorporate counters such as the DS2423.

Counter Page
The Counter Page combo Listbox selects the page that is associated with the
counter to read.

Counter Value
The Counter Value is the current value of the counter from the last sample.  The
counter value is represented as a decimal number.

Calculation
The Calculation box contains the sample rate and various calculations on the
counter as it changes with time.

Sample Rate
The Sample Rate when the counter is read and the calculation performed.  The
range is 0.5 to 32 seconds.  Due to Window’s multitasking, the sample rate is
approximate.
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Elapsed Count
The Elapsed Count depicts the increase in the value of the counter from start of the
sample session.  A sample session will begin when the viewer is started, when the
counter page is changed, or when the ‘Reset Sample’ button is clicked.  At the
beginning of a sample session, the elapsed count will start out as 0.

Elapsed Time (S)
The Elapsed Time depicts the total time in the current sample session.  The elapsed
time, represented in seconds, will be updated when the counter is read at the
sample rate.

Counts / Second (Average)
The ‘counts per second average’ is simply the elapsed counter divided by the
elapsed time.

Counts / Second (Last)
The ‘counts per second last’ is defined as the change in count from the last sample
to the change in time from the last sample.  For example, if the sample rate is 2, and
during the last sample period the counter changed 10 then the counts per second
would be 10 / 2 = 5.

Reset Sample
The ‘reset sample’ button clears the current sample session and starts a new one.
The elapsed count and elapsed time are reset to zero.
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File Viewer
The file viewer is the common tool to access the memory of any 1-Wire device with
at least 1K bit of memory. It is capable of reading and writing devices manufactured
in SRAM, EEPROM and EPROM technology. The file viewer supports the 1-Wire
File Structure file format. Valid file names are maximum four characters long and
have a numeric extension in the range of 0 to 99 (decimal). With EPROM devices it
is possible to create so-called “append files”. Append files can be modified by
appending data at the end of existing data. This provides an economic way of
updating information without re-writing the whole file, as it is normally done in file
oriented systems. A file is created as an “append file” if one specifies an extension of
100.   Extension 101 is reserved for “monetary files”.  See the section ‘Editing
Monetary Files’ for details.

As any advanced file system, TMEX allows organizing files into several levels of
sub-directories (see App Note 114). As a consequence, accessing a file requires two
steps: first, selecting the file in the directory tree; second, displaying the file’s data. If
the file is new, one first has to select the directory where the file is to be created and
then create it. For this reason the file viewer operates through two windows: the
Directory Window to select/create a file and the File Editor Window to read/edit its
contents.

Understanding the Directory Window
The Directory Window consists of three major sections:

file Listbox (left) to display file and directory names,
information area (center) to display information on the selected file,

directory and device
button area (right) with buttons for the four most often used file

functions.
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File Viewer, Directory Window

In addition, the Directory Window has a Status Bar and a Menu Bar. The Status
Bar indicates the type and number of the port through which the selected device is
accessed. After one has begun a write session to an EPROM device the message
“Program Buffer Enabled” appears in the center of the Status Bar. This is to remind
that all changes are collected in a buffer to be written all at once to minimize the
consumption of memory space. Before actually writing, the program checks the
population of the 1-Wire bus. The message “Non program devices detected on the
1-Wire Net! Programming voltage may damage these non-program devices.
Remove these devices and then click OK.” will be displayed if non-EPROM devices
have been found and writing will not take place unless these devices have been
removed.

File
Listbox

Status Bar

Information

Current Directory
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File and device functions that are needed less often are accessible through the
Menu Bar. The menus and their functions are:

File Rename to change the name (not the path) of a file
Attribute to toggle the attribute of a file between normal and “read-only”
or to toggle the attribute of a directory between normal and “hidden”,
Program Now to copy the buffer contents to the EPROM device
Exit to exit the file viewer

Tools Format to prepare a memory device for the storage of data files
View Refresh to re-read the directory information and update the File Listbox

Show Hidden to include hidden directories in the File Listbox in order to
select one and reverse its hidden attribute

Managing Files and Directories
The File Listbox presents a list of the files and sub-directory entries in the current
directory on the device.  Revision 3.20 of the iButton Viewer does not allow sorting
files. Therefore, files are listed in the same sequence as their entries are stored in
the device directory. As more files or directories are created or deleted, this
sequence may change.

A file or directory is selected in the File Listbox by clicking on it once. Under the
headline “File” in the information area, the file size in granularity of the data page
size of the device type is displayed.  Also displayed is the file’s physical starting
page address. A directory is not considered to have a size; therefore only its starting
page is displayed. Double-clicking on a file name or clicking on the Select Button
opens the File Editor Window. Double-clicking on a directory name changes from the
current directory to the sub-directory. The path to the sub-directory will be displayed
just above the File Listbox.

In the information area under the headline “Directory” the total number of files and
directories in the current directory level is displayed together with their combined
size in a granularity of the data page size. The total balance of used and unused
bytes within a device is shown under the headline “Device”.  Note: a 32 byte memory
page can only store 28 bytes since four bytes per page are reserved for formatting
and CRC protection.

If one has entered a sub-directory the File Listbox begins with two dummy files
marked as “. <DIR>“ and “.. <DIR>“. The first one is identical to the current directory.
The only effect from clicking on it is getting the physical page address of the sub-
directory displayed under “File”. The second one is the reference to the next higher
directory level. Clicking on it once displays the physical page address of the higher
directory. Double-clicking it changes from the current level to the next higher one.
These dummy files are counted when determining the total number of files in a sub-
directory.

Formatting A Device
Like a floppy disk, a fresh memory iButton needs to be formatted before data files
can be written to it. If the user has selected a device and starts the file viewer, the
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program first tries to read the device directory. Since an unformatted device does not
have a directory this reading will fail. The user will get the error message: “Could not
read the directory! Format the device now ?” Simply click on “OK“ and the device will
be formatted. Clicking on “CANCEL” will not format the device. However, upon
attempting to create a file, the message “Error reading the directory, operation
aborted!” will be displayed. After the formatting is completed the confirmation
message “Device successfully Formatted!” will be displayed.

Formatting is required in any case, regardless of SRAM or EPROM technology.
When formatting an EPROM device, the program will give several notifications to
alert the user of the special conditions that apply. The first message is: “WARNING,
a buffer has been created to log changes to this EPROM device. Do NOT change
the memory of this device in any other window!” This is to remind the user, that
although it is possible the device should not be written to through more than one File
Viewer window. With SRAM based devices this is not a problem since data is written
immediately without buffering it. A further warning “The Program Buffer will be
written when this window is exited or from the file menu. Aborting the EPROM write
will negate any changes made.“ is then displayed. This confirms that any physical
writing will be delayed until the file viewer to the device is exited. All data changes
until then will be collected in a buffer.

A device may be re-formatted at any time. With an SRAM-based device this will
erase the device directory and release the memory space to store new data. As with
the “Quick Format” function the memory is not physically cleared. Although most of
the data remains in the device, the links to it are lost. Re-formatting an EPROM-
based device is also possible. However, one will not be able to re-gain memory
space for new data. The only effect of re-formatting is clearing the device directory
so that the existing files will no longer be found by the File Viewer. As explained in
the data sheets of EPROM-based iButtons, the current directory is just re-directed to
an unused page. This leaves the links to old files intact and makes them still read-
accessible with customized software.

To re-format a device, click on “Tools” in the Menu Bar and click on option “Format”.
This will display a message “Format this device now?”. Click on “OK” and the device
will be formatted. The end of formatting will be confirmed in the same way as with a
fresh device.

Creating and Writing A File
To create a file, click on the “Create File” button. This will open a child-window
where the name of the file is to be entered. The file name consists of up to four
characters and a file extension in the range of 0 to 99 (decimal). The extension is
separated from the file name by a decimal point. If no extension is entered, the value
000 will be assigned by default. After the file name and extension are entered, click
on “OK”. The program returns back to the Directory Window where the newly
created file name will show up in the File Listbox. Now double-click on the file name
or click once on the name and once on the select button. This will open the File
Editor Window where the empty file is to be filled with data.
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With EPROM devices the extension 100 is also permissible if one intends to create
an “append file”.  Another specialty extension is 101 for DS1963/DS1962 Monetary
iButtons.  The Monetary file is a single page file in a special part of memory that has
a read-only counter associated with it.  The counter increments with each write to
the page and can be used to detect tampering to the file.

Creating A Directory
To create a directory, click on the “Create Directory” button. This will open a child-
window where the name of the directory is to be entered. The maximum length of a
directory name is four characters. After the directory name is entered, click on “OK”.
This transfers back to the Directory Window where the newly created directory will
show up in the File Listbox. To enter the directory, double-click on the directory
name. Now the File Listbox will contain only the two dummy files “. <DIR>“ and “..
<DIR>“. Files can be created in the directory as described in the previous paragraph.

Deleting A File or Directory
To delete a file, select the file in the File Listbox by clicking on it once and then click
on the “Delete” button. The program will ask for a confirmation. Click on “OK” to de-
lete the file. To delete a directory, select the directory in the File Listbox by clicking
on it once and then click on the “Delete” button. As with a file, the program will ask
for a confirmation. Click on “OK” to delete the directory. The directory will only be
deleted if it is empty. Otherwise an error message “Directory is not empty, operation
aborted!” will be displayed. This message needs to be acknowledged by clicking on
“OK”. After all the files in the directory are deleted individually, the deletion of the di-
rectory will be successful.

Renaming A File
To rename a file, select the item to be renamed in the File Listbox by clicking on it.
Then click on “File” in the Menu Bar and click on option “Rename”. This will open a
child-window with a field for entering the new file or directory name. After the name
and extension are entered, click on “OK”. This will update the name and close the
child-window. Note: It is not possible to convert a file to an “append file” or vice
versa by renaming it. Renaming is only possible as long as the new extension does
not indicate different file characteristics.

Moving A File
There is no direct way to move a file from one directory or device to another. If
moving a file within a device, open the file first in the File Editor Window and copy its
contents to the clipboard (see File Editor description, Copy All). Exit the file editor
and delete the file. Now go to the directory the file is supposed to be moved to and
create the file name. Next open the file and paste in the contents of the clipboard
(see File Editor description, Paste All) and exit the file editor.

Moving or copying a file from one device to another is done in a similar way. First the
contents of the source file needs to be copied to the clipboard. Then the file name is
created in another device and the contents is then pasted into the opened file and
written to the target device. This procedure works independent of the device
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technology. It is possible to copy the contents of an “append file” to an SRAM de-
vice. However, the extension of the copy must be different from 100.

Attributes
The 1-Wire File Structure is able to set attributes for files and directories. Possible
attributes are “read-only” (R) for files and “hidden” (H) for directories. To make a file
read-only, select the file in the File Listbox, open the “File” menu in the menu bar
and click on option “Attribute”. This will open a box with the text “  Read Only”. Now
click on the box and the attribute of the file will change. The character “R” will now
appear to the right of the file name in the File Listbox. To reverse the “read-only”
attribute, follow the same steps again. Instead of “  Read Only” the contents of the
box will be “√ Read Only”. Now click on the box and the attribute of the file will be
reversed. Clicking anywhere else will not change the attribute.

To hide a directory, select the directory in the File Listbox, open the “File” menu in
the menu bar and click on option “Attribute”. This will open a box with the text
“  Hidden”. Now click on the box and the directory will no longer be found in the File
Listbox. To make a hidden directory visible again, open the “View” menu in the menu
bar and click on Show Hidden. This will list the hidden directory (if any) in the File
Listbox with the character “H” to the right of the name as attribute. To make the
hidden directory permanently visible, select it in the File Listbox, open the “File”
menu in the menu bar and click on option “Attribute”. This will open a box with the
text “√ Hidden”. Now click on the box and from now on the directory will be listed
again. Clicking anywhere else will not change the attribute.

Show Hidden
This option of the “View” menu is implemented to find hidden directories, select them
and make them visible again. For details on the use of this option, see the descrip-
tion under “Attributes”.

Refresh
Since it is possible to access a single device through more than one directory win-
dow it may be possible that one window shows files that have already been deleted
through another window or does not show items that just have been created, for ex-
ample. To avoid uncertainty caused by contradicting information, the refresh option
has been implemented. To refresh the contents of the Directory Window, open the
“View” menu in the menu bar and click on “Refresh”. This will automatically re-read
the device directory and display the updated information.

Program Now (EPROM only)
If one intends to write to an EPROM device before closing the Directory Window,
one can do this through the option “Program Now” listed under “File” in the menu
bar. After having selected this option, one will get the message: “Program the
EPROM device now? CANCEL will leave the device unchanged.” To actually write
the new information to the device, click “OK”. Clicking on “Cancel” will not write but
keep all changes in the buffer. If one does not use the “Program Now” option, one
will get the message “Program the EPROM ...” on exiting the Directory Window. If
one now clicks on “Cancel”, however, the buffer will be cleared all changes are lost.
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File Editor Window
The purpose of the File Editor Window is to examine and edit an iButton file that has
previously been selected in the Directory Window of the File Viewer. Files can be
viewed in three different ways: as ASCII Text, Binary Data in hexadecimal format
and BMP Picture. These different views are reflected in the three tabs that fill the
center of the File Editor Window (see below).

The name of the selected file and its path are listed above the display area. The
mode of viewing is determined by the file contents. The file extension, except for
values of 100 and higher, does not indicate the file type. If a file is recognized as
BMP formatted picture it will be displayed as such. If a file is not a picture and does
not contain Null bytes (code 00 hex), it is assumed to be ASCII text. Otherwise its
contents will be displayed as binary data. An empty file will be treated as text. Text
can be edited in text mode as well as in binary mode. Binary files can be edited in
the binary mode only. Although pictures can be displayed with the file viewer, they
have to be edited using special graphics programs.

Regardless of the file type, one can change the viewing mode by clicking on the
label of the tab. However, if the representation is not adequate to the file contents,
one may get error messages (when trying to view a text or binary file as BMP picture
or viewing a picture as text, for example) and editing may not be possible.
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File Viewer, File Editor Window, Text Mode

The File Size of the file being viewed or edited and its maximum possible size are
indicated beneath the viewing tabs. In contrast to the file size in the Directory
Window, which is rounded upwards to the next multiple of 28 bytes, the file size
shown in the Editor Window is always exact. When editing text, the number will in-
crease or decrease as characters are added or deleted. In Binary mode the file size
is updated whenever a group of bytes has been revised (see “Editing Binary Files”,
below).

The Estimated File Max{imum} Size is calculated from the number of unused pages
within the device plus the number of pages already used. This estimate usually is
very accurate. Under certain conditions, however, the file may finally be up to 28
bytes longer than the estimate displayed. Extensive use of sub-directories reduces
the memory space available for data storage.

To the right of File Size and Estimated File Max there are two buttons, “Write File”
and “Cancel”. The Write File button has to be clicked on if the changes made during
an editing session are to be written to the device. With an SRAM device, data will be
written immediately. With an EPROM device one will get the message that a buffer
is created and no writing will take place before leaving the file viewer or the Program
Now function (Directory Window, File Menu) has been invoked. Clicking on Cancel
will close the File Editor Window and transfer back to the Directory Window ignoring
all edits made during the session. If one has modified a file and tries to close the edi-
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tor window, one will be reminded of this by the message “File had changed. Update
Now ?” Click on “OK” to save the changes or on “Cancel” to exit without updating.

The Menu Bar of the File Editor Window contains elementary functions to exchange
data between the iButton and the PC and the Windows Clipboard, respectively.
These menus and their functions are:

File Open File (PC) to select an file on the PC to replace the entire contents
of the iButton file,
Save File (PC) to copy the entire iButton File to the PC
Exit to exit the file editor window

Edit Copy All to copy the entire contents of the iButton file to the clipboard,
Paste All to replace the entire contents of the iButton file with data from
the clipboard
Clear

View Proportional to temporarily change to a non-proportional font (text tab
only)

Transfers to the iButton will only be successful if the data does not exceed the stor-
age capacity available in the device. Otherwise one will get an error message and
the remainder of the file data or clipboard contents will be cut off.

Editing Text Files
If a newly created file is selected, the cursor will be in the beginning of the empty text
tab. Now one can type, erase and edit text similar to the Windows Notepad utility. All
standard Windows keystroke editing commands apply. The most useful of these are:

Cut =  Shift + Del
Copy =  Ctrl + Ins or Ctrl + C
Paste =  Shift + Ins or Ctrl + V
Clear =  Ctrl + Del

In contrast to the menu functions, the keystroke commands affect the selected text
section only, not the entire iButton file. When editing tables it may be useful to
change the character font to a non-proportional one. To do this, click on the View
menu. This will open a box with the text “√  Proportional”. Click on the box to change
to the non-proportional font. To change back to a proportional font, repeat these
steps. The check mark “ √ “will now be missing.

To copy a file from the PC to the iButton file, use the function Open File (PC) from
the File Menu. The program will then display all “TXT” files found in the directory
where the iButton Viewer Program is installed. The file selection can be changed to
list “BMP” only or to include all files. However, the file size will not be visible. One
can change the directory following the Windows convention to access any file stored
in the computer. After the file in the PC is found, double-click it or click it once and
then click OK to transfer its contents to the file editor, replacing previous data. De-
pending on the data transferred, the editor may change automatically to the binary or
BMP display mode.



TMEX Runtime Environment

110701 57/90

To copy a segment of a file to the iButton, access the file with a text editor or word
processor and copy the segment to the Windows clipboard. Then return to the File
Editor window and use the function Paste All from the Edit Menu. This will replace
the previous contents of the iButton file with data from the clipboard.

Data can be copied from the iButton to the PC in two different ways: into a file of
its own or to the clipboard to be incorporated into an existing file. To copy to an in-
dependent file, use the function Save File (PC) from the File Menu. By default, the
program will create the file in the directory where the iButton Viewer Program is in-
stalled. The file name on the PC will be the same as in the iButton. For text files the
extension will change to TXT and to BMP if one is copying a picture. Binary files will
keep their original extension. However, name, extension and path of the file may be
changed, if desired. To copy from the iButton to the clipboard, use the function
Copy All from the Edit Menu. ASCII text or a picture can now be pasted into a word
processor document and be re-used. Copy All does not work with binary files.

Editing Binary Files
Any file can be displayed and edited in the binary format. The picture below shows a
sample text file in hexadecimal presentation. Each line starts with the byte address
inside the file (not the device) followed by 8 bytes of data, each separated by a
space. With an empty file one will only see the address information [000].

To enter or edit data, double-click on the line where the editing is to begin. This will
select all eight bytes in that line and copy them into a child-window, as in the exam-
ple below, where the editing takes place. Click anywhere in this line to set the cur-
sor. Entering new data without setting the cursor will replace the whole line.

Data can be inserted or overwritten as in any typical Windows Application and is not
limited to the 8 bytes of the line. Even the keystroke commands apply, but their use
is rather limited. Input data may be hexadecimal or ASCII. Groups of two characters
in the range of 0 to 9, A to F (not case sensitive) separated by a space are under-
stood as hexadecimal (see picture). Single characters separated by a space are un-
derstood as ASCII and are translated into their Hex equivalent. Hexadecimal and
ASCII data may be mixed in the same line during editing. Spaces themselves are
delimiters and therefore cannot be entered as character, only as code 20 hex.

After the new data is entered, click on OK to transfer the edits to the main window
where it will be inserted from the selected line onwards. Any changes in length will
be reflected in the File Size below the display section.
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File Viewer, File Editor Window, Binary Mode

File Viewer, File Editor Window, Binary Mode, Hex-Editor Child-Window

Handling Picture Files
The picture mode has been implemented to support viewing bitmap files stored in
iButtons and exchanging them between the iButton and PC. Bitmap files (file ex-
tension BMP) are created using programs such as Paint (PBRUSH.EXE) and other
graphic programs. They are pasted into a previously created and opened iButton file
using the “Open File (PC)” function of the File Menu or “Paste All” of the Edit Menu.
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Data transfer of BMP or JPEG pictures to the PC is also possible. Use the File Menu
function “Save File (PC)” to create a disk file or the Edit Menu function “Copy All” to
copy to the clipboard from where the picture can be pasted into a word processor
document, for example.

Although picture files can be displayed and edited in the binary mode, it is not
recommended to do so unless the exact format of the BMP files is known in great
detail. Changing or adding bytes arbitrarily is likely to corrupt the file and may lead to
unpredictable results. The file may not even be recognized as a picture.

File Viewer, File Editor Window, BMP Mode

Editing EPROM Append Files
Append files may contain text or binary data. They are viewed in the same way as
any other data file. However, there are some notable differences. After one has se-
lected an append file in the Directory Window the following message will be dis-
played: “The file selected is an AddFile. The data entered will be appended to the
end of the file. Note that the current contents of the file is displayed.” After clicking
on OK the message will disappear and one can read the full file contents, either in
the text or binary mode.

As soon as one clicks anywhere in the display area of the tab, the display area will
be cleared and one can enter the data to be appended. In binary mode the first line
will show the address of the next available byte of the file. After data entry is finished
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one proceeds in the same way as with other text or binary files that are to be written
to EPROM devices.

There are no restrictions on the data within an append file. The program determines
the end of data by loading the append file into a buffer and then scanning it back-
wards (i. e., from the highest to the lowest address). The address of the first byte
found that is different from FF hex is taken as “end of file marker”. The starting ad-
dress for new data will be “end of file marker” + 1. Since unprogrammed EPROM
memory cannot be distinguished from a byte that deliberately has been written FF
hex, the data of an append file must not end with FF hex. Otherwise it will be over-
written with new data in the next session. This special precaution does not apply to
text files since FF hex is not a valid character code.

Editing Monetary Files
Monetary files must reside on DS1963L devices and have a 101 decimal extension.
They have specific pages that are associated with read-only counters that
increments when the page is written.  This is used to detect tempering of the
monetary file.  When creating a Monetary file the following a message will be
displayed  “Extension 101 is reserved for transaction type files.  This type of file is
located in a special memory page with a counter. Is this what you want?”  After
clicking ‘OK’ the file will be created.  When reading a Monetary file, the current
counter and temper bits for the page the file is located on is displayed in a message
box.
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Time Viewer
The Time Viewer is an easy to use tool to read and set all of the counters and
registers in the register page of the DS1994 (DS2404) iButton device. In addition,
one has full access to the control and status register, which makes it possible to use
all of the device’s special features. The Time Viewer Window with sample settings is
shown below.

The window consists of three major sections labeled “Clock/Counters”, “Alarm Reg-
isters”, and “Miscellaneous Settings”. In the “Clock/Counters” section the viewer
displays and periodically updates the readings of the three counters of the device.
These counters are called Real Time Clock (binary format, UNIX-compatible), Inter-
val Timer and Cycle Counter. Associated with each counter is an Alarm Register of
the same size. The contents of these registers is shown in the section “Alarm Regis-
ter”. Bits and flags that control the device operation are found either with the count-
ers (interval timer control “Auto, Manual”; “Stop, Start”), the Alarm Registers (alarm
enable, one for each counter) or in a separate section “Miscellaneous Settings”
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(Oscillator Enable, Delay Select, Read RAM after Expiration and Write Protect/Ex-
piration). As with the other windows, there is also a Status Bar that indicates the
communication port in use and a short Menu Bar with the entries File (to exit the
Time Viewer) and Tools (to set the clock).

Changing Settings
Any setting in the white fields of the display and control sections can be changed by
simply clicking on it. For control functions, the contents of the field will toggle
between “×“ as a check mark and plain white. For registers a child window will pop
up with the present contents of the register. To replace the contents completely,
simply type the new value. Otherwise position the cursor, select the portion to be
replaced and start typing, just as with Notepad, for example. After the new value is
entered, click on “OK” to transfer the value to a buffer or click on “Cancel” to ignore
the editing. The new value will be displayed in purple and two temporary buttons
“Write” and “Abort” will appear below the Menu Bar. One may write each change
individually or collect the changes of several controls and registers in the buffer and
write them all at once. When write-protecting one or more counters, all the updates
must be collected and written all at once. For the change(s) to become effective one
has to click on the “Write” button. “Abort” will return to the previous settings without
writing the buffer. Regardless if data is written the temporary buttons will now be
gone. Closing or exiting the Timer Viewer while the temporary buttons are visible will
ignore the updates collected in the buffer.

Operating the Clock
The real-time clock of the DS1994 (DS2404) is a 40-bit binary counter that
increments 256 times per second. The 8 least significant bits count the fractional
seconds. The upper 32 bits represent the number of seconds passed since January
1st, 1970, 0:00:00 hours (= 12:00:00 a. m.) as reference point. The 40 bits of the
real-time clock can accumulate 136 years before rolling over.

With a DS1994 (DS2404) as shipped from the factory the real-time clock is not
running. To set the time, click on the white field right of the text “Real-Time Clock”
and enter the actual date AND time in the format MM/DD/YYYY hh:mm:ss (24-hour
format). Alternatively one can use the function “Set Real-Time Clock From PC
Clock” of the Tools Menu. In addition to setting the clock, the crystal oscillator needs
to be enabled to get the clock running. To do this, click on the small square field
“Oscillator Enable” in the Miscellaneous Settings section until the “×“ appears and
click on the temporary “Write” button below the Menu Bar. Now the real-time clock
should be running and one should see how the date and time are constantly
updated.

The crystal oscillator can be turned off by clicking on the “Oscillator Enable” control
field until the “×“ disappears. This will conserve energy if the device is not in use for
a long time. However, for the interval timer and cycle counter to function the
crystal oscillator that controls the real-time clock must be enabled.
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Operating the Interval Timer
The interval timer is a 40-bit binary counter that, when enabled, counts at the same
rate as the real-time clock. Its contents are displayed in seconds as a decimal
number with fractions. The interval timer is either in the Automatic or in the Manual
operation mode. The Automatic Mode is selected if the white square “[×] Auto  [  ]
Manual” in the Clock/Counter section of the Time Viewer Window contains the “×“
check mark. Otherwise the timer is in the manual mode.

In the Automatic mode, the interval timer will begin counting after the data line has
been high for a period of time determined by the Delay Select bit (see description
below). The interval timer will stop counting after the data line has been low for the
same time period. The automatic mode can be useful when monitoring the operating
time of equipment. Simply provide a DC voltage in the range of 2.8 V to 6.0 V to the
data contact of the DS1994 (DS2404) as long as the equipment is powered up.
Removing the device and reading the interval timer will tell exactly how many
seconds the equipment was running.

In the Manual mode, the interval timer is operated under software control. It is either
running or stopped, regardless of the voltage on the data line. One may toggle
between start and stop by clicking on white control field “[×] Stop  [  ] Start”. The in-
terval timer is stopped, if the control field contains the “×“ check mark. Otherwise the
timer is running and one will see that its contents are periodically updated. Although
one may change its setting, the Stop/Start control field has no function if the device
is in the Automatic mode. The Manual mode can be useful when monitoring how
long  computer-controlled equipment is really productive (not just powered up).
Whenever the equipment changes from idle to active, its controlling computer should
start the interval timer and stop it as soon as the equipment returns to the idle state.
In addition to this counting service the DS1994 (DS2404) also provides time and
date information for event logging purposes and non-volatile memory for setup data.

To preset or clear the interval timer, click on the white field right of the text “Interval
Timer” and enter the new value as a decimal number (integer or with decimal point,
no comma). See section “Change Settings” above for details. The maximum value
the interval timer can be preset to is approximately 4294 million (decimal) with a
granularity of about 1/100 of a second.

Operating The Cycle Counter
The cycle counter is a 32-bit binary counter. It increments after the logical level at
the data line changes from high to low and then stays low for a period of time
determined by the Delay Select bit (Miscellaneous Settings section).

The cycle counter can be useful when monitoring the number of power up/down
cycles of equipment or just counting pulses that represent revolutions of an object,
for example. For cycle counting, connect a DC voltage in the range of 2.8 V to 6.0 V
to a switch and connect the switch to the data contact of the DS1994 (DS2404).
Every time the switch closes and opens the cycle counter will increment. In the
example given for the Automatic mode with the interval timer the cycle counter will
automatically count the power up/down cycles, thereby supplementing the run time
information with stress information.
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To preset or clear the cycle counter, click on the white field right of the text “Cycle
Counter” and enter the new value as decimal integer number. See section “Change
Settings” above for details. The maximum value the cycle counter can be preset to is
approximately 4294 million (decimal).

Delay Select
The cycle counter and interval timer of the DS1994 (DS2404) are designed to work
with digital signals as well as mechanical switches. A mechanical contact closure,
however, is not a clean transition from an off to an on state. At a closer look one can
see that a mechanical switch generates a series of uncontrolled short pulses
(“bounces”) until it finally reaches the steady on or off state. Therefore the DS1994
(DS2404) has an on-chip debouncing logic that filters the transitions and provide
clean signals that finally control the counters.

One can set the time delay of the debouncing logic to either 123 ± 2 ms or 3.5 ± 0.5
ms. If possible, the longer delay should be chosen. This gives a good filtering and
also allows communication on the data line without incrementing the cycle counter or
starting the interval timer (if the communication occurs in short data packets with an
idle low status). The shorter delay allows higher counting speeds, but under certain
conditions may lead to incrementing the cycle counter by wave forms that the device
generates itself (interrupts).

The Delay Select bit is found in the Miscellaneous Settings section of the Time
Viewer Window. A check mark “[×]” in the control field left of “Delay Select” indicates
the long delay, a missing mark represents the short delay. To toggle between the
two delay values click on the control field and proceed as explained under
“Changing Settings”.

Using Alarms
To generate an alarm two things need to come together: the value of the counter
must be equal to the value of the alarm register AND the alarm must be enabled.
Setting the registers and enabling the alarms is done through the Alarm Registers
section of the Time Viewer window. Alarm values are entered in the same way as
counter values. To enable an alarm, click on the control field left of the name of the
alarm type until the check mark “[×]” appears. This arms the device to generate
interrupt signals as the alarm goes off. To disable the alarm, click again on the
control field. The check mark will disappear. After the value is entered and the alarm
is enabled, proceed as explained under “Changing Settings”.

The iButton Viewer will perform a Conditional Search for all DS1994 (DS2404)s
being viewed and read the Status Register as soon as an alarm has gone off. The
type of alarm (time, interval or cycle) is then determined from the settings of the
alarm flags inside the status register and a message like the sample below is
displayed.
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Reading the status register automatically clears the alarm flags. Once an alarm is
enabled, it can be armed for the next event by writing a higher value into the alarm
register or resetting the counter.

Compared to having the bus master permanently reading the counters and checking
against a limit, using alarms in conjunction with interrupts is very efficient. It reduces
traffic on the 1-Wire Net and makes sure that the master is informed the fastest
possible way. Even if, due to poor electrical contacts during reading, the status of
the alarm flags are lost, their status can be reconstructed by comparing counter
registers and alarm registers and checking the interrupt enable bits.

Write Protect / Programmable Expiration
The DS1994 (DS2404) can be used as a programmable expiration controller, for
example, to force a service call if a machine has been used for a predefined number
of operating hours, a certain number of power on/off cycles, or if a certain date is
reached. This mode is invoked by write protecting a counter/alarm register pair after
it has been loaded with the desired values. The programmable expiration takes
place when one or more registers have been write-protected and the first alarm
condition occurs.

The behavior of the DS1994 (DS2404) after expiration is determined by the “Read
RAM after Expiration” flag, located next to the Write Protect flags in the
“Miscellaneous Settings” section of the Time Viewer Window. If this flag is set (check
mark “[×]” is visible) one will still be able to read the memory, but any writing will be
impossible after expiration. If this flag is not set (no check mark), only the ROM
contents can be accessed after expiration. Before expiration the status of this flag
has no impact on device operation.

Write-protecting counter/register pairs protects not only the register pair from
modification but also all other write protect bits and the “Read RAM after Expiration”
flag. The oscillator can still be started, but not stopped. If the cycle counter is write
protected, the Delay Select setting can no longer be changed. Write protecting the
interval timer also freezes the operation mode of the interval timer. If the timer is in
manual mode, it will run continuously as soon as the write protection becomes
effective.

The expiration controller function works even if the alarm for the particular register is
not enabled. If the alarm is enabled, the expiration will be signaled by interrupt
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pulses. In this case the “Read RAM after Expiration” flag should be set. Otherwise it
will not be possible to stop the interrupt signals that go along with the expiration and
slow down the communication on the 1-Wire Net.

To invoke the expiration controller mode, first set all counters to their starting
values and the associated alarm registers to the value that marks the expiration.
Enable the alarms (optional) and set the “Read RAM after Expiration” flag (unless
the memory must not be accessible after expiration). All these settings are not
critical and can be repeated. In the final step, set the write protect/Expiration bit for
the counter(s) that shall determine the expiration. If the expiration shall be triggered
by the counter that reaches its limit first, then write-protect all counters that apply
and then write the buffered changes to the device. Once a counter has been write-
protected one cannot protect another one.

The Write Protect / Expiration Controller function is not reversible. The chance
to inadvertently invoke this mode is low. In contrast to the other settings, the
program will pop up an extra window (see below) and ask for confirmation.

Only if one clicks on “OK” is the Write Protect / Expiration Controller function really
activated.
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Secure Viewer
The Secure Viewer is used to read and write the DS1991 MultiKey iButton. In con-
trast to Memory iButtons, this device uses a file system that is implemented in
hardware. The device is designed to store three files of 48 bytes each that are called
Subkeys. Instead of 4 bytes with a numeric extension, the file name consists of 8
bytes and is called ID Field. In addition to the ID Field, each file has an 8-byte write-
only password to protect its contents from unauthorized read access.

As with the other Memory iButtons, this device also includes a scratchpad. The
scratchpad may be used to write data and read it back for verification before it is
copied to its final destination in one of the Subkeys. With its 64 bytes, the scratchpad
of the DS1991 can hold the ID Field, Password and all 48 data bytes of a Subkey.
The usage of the scratchpad for intermediate storage is highly recommended for an
environment where dwell time of the device at the 1-Wire network is short. Assuming
that the dwell time is long enough, the iButton Viewer does not use the scratchpad
and writes directly to the Subkey. As a consequence, the scratchpad becomes
available as an additional publicly accessible memory space.

All of the memory areas of the DS1991 MultiKey iButton with the ID fields and pass-
word-entry boxes of the three Subkeys are laid-out in the window of the Secure
Viewer in a straight-forward way, as shown below.

The three Subkeys combined into a block “Secure Subkeys” fill the lower three quar-
ters of the window. To the left, above each Subkey’s data field there is a box labeled
“ID” to display the contents of the key’s ID Field. Above the center of each Subkey’s
data field is another box labeled “Password”. When reading a Subkey, one has to
type the password into this box to give the program access to the secure data.
Above the block of Subkeys there is a smaller block called “Scratchpad”. The
scratchpad is represented as one line that displays the contents of the scratchpad in
character form. As usual, the window is completed by a Status Bar that indicates the
communication port in use and a short Menu Bar with the entries File (to exit the
Secure Viewer) and View (to refresh the screen, in case a single device is viewed
through multiple windows). This sample picture was generated using a device in the
state as it is shipped from the factory. The “U”s are the ASCII representation of the
character code 55 hex (= 85 decimal), a pattern that typically is written to the device
before it leaves the factory.
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The Secure Viewer does not know or remember passwords. To meet the re-
quirements of the communication protocol the viewer uses 8 spaces (code 20 hex or
32 decimal) as password when trying to read the Subkeys. Since this is usually
different from the correct password, the device responds with “garbage” data, a
pseudo-random pattern based on the provided password (not the stored one). The
“garbage” is then checked for its printability. All non-printable codes, i. e., codes
below 20 hex (32 decimal), are replaced by a “.” before data is displayed in
character form as Subkey contents. Depending on national settings, the characters
actually seen may be different from those shown in the sample window.

Writing Secure Data
Before one can write secure data to a Subkey for the first time, one has to give the
Subkey a name (optional) and specify a password (mandatory). To change the
name of a Subkey, click on the box that displays the current contents of the key’s ID
Field. This will open a child-window with the current name already selected for re-
placement, as shown below.
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Enter the new name and click OK. This will bring up a similar window for setting the
password.

The default password of the Secure Viewer is 8 spaces. All but the first space are
removed from the editing area of this child-window. The remaining single space is
selected for replacement. Simply fill in the new password and click on OK. Clicking
on “Cancel” will ignore the new name as well as the password. For both, the ID Field
and the password, the program allows up to 8 characters, including embedded
spaces, to be entered. Shorter names are padded with spaces to make the 8
characters necessary to meet the hardware requirements of the device.

After file name and password have been entered, the new names will be visible for
the Subkey selected. Since writing a password erases the contents of the Subkey,
the Subkey’s data field will now be filled with 48 dots, representing the non-printable
code 00 hex. Now double-click on the dots to select them for replacement and type
the new contents of the Subkey. With the first character entered, a “Write” button will
appear above the right end of the Subkey’s data field. When finished typing, click on
this temporary button to transfer the text to the secure Subkey. The text entered will
be appended by spaces to fill the 48 bytes of the secure storage space of the key.
To cancel the transfer without writing, exit the window of the Secure Viewer or click
on “Refresh” in the view menu. After the data is written to the device, the “Write” but-
ton will disappear, but the file name, password and contents will remain visible. To
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make the password and the true contents of the Subkey invisible, overtype the
password.

Reading Secure Data
To read secure data, click on the password-entry box of the key to be read and type
the password. When the typing ends, the program assumes that the password is
complete and will access the device. If the password is correct, the secure data will
be displayed in its true length, with trailing spaces removed. Otherwise the display
will show random data, based on the password entered. Note that the password is
case-sensitive and must be entered exactly as it is stored in the device. Although the
program fills short passwords with trailing spaces to make up the 8 bytes required by
the DS1991, these trailing spaces need not be entered.

Modifying Secure Data
After secure data is read from one of the Subkeys of the DS1991 it can easily be
modified and written back to the device. First access the Subkey as described in
section “Reading Secure Data”. Now double-click on the word to be replaced and
enter new text. To replace a selection, select the text to be replace with the mouse
and type the new text. To replace the whole contents, select the full line. Alterna-
tively, one can position the cursor anywhere in the data field and start erasing or
typing, whatever is necessary. The program counts the characters and stops
accepting more data as soon as the data field contains 48 characters. As described
in section “Writing Secure Data”, a “Write” button will appear that needs to be clicked
to finally write to the device.

Changing the ID Field And/Or Password
The Secure Viewer allows the user to change the ID Field of a Subkey and its
password while keeping the Subkey’s contents. However, this is a multi-step
procedure involving the Windows clipboard and keystroke commands. The
procedure begins with displaying the contents of the subkey who’s ID or password is
to be changed. See section “Reading Secure Data” for details. Next select all the
contents of the Subkey’s data field with the mouse and copy it to the clipboard using
the keystroke command Control + C.

Now click on the display area of the Subkey’s ID Field. This will pop up the child-
window for entering the file name with the current name filled-in and selected. Make
changes as desired or click on OK. This will transfer to the password child-window
with the current valid password filled-in and selected. Make the desired changes and
click on OK. This will write the new ID and password and erase the Subkey’s
contents. Now double-click on the Subkey’s data field that is now filled with dots and
paste in the contents of the clipboard using the keystroke command Control + V.
Now click on the “Write” button to write the data to the device.

Trying to change the password by simply typing new text in the password field is not
possible. The programs would assume that one is going to try another password for
reading the Subkey’s contents. Changing the data field of the Subkey first and then
the password before writing to the device will give the error message “Error writing
the sub-key, password may be incorrect !”. This comes from the fact that the
program tries to write to the device using the password shown on the screen. In the
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read-back cycle after writing the program will then see that the data does not match
and therefore display the error message.

Reading/Writing The Scratchpad
With the Secure Viewer the scratchpad is treated as a Subkey without ID Field and
password. The current contents therefore are displayed automatically. For editing
and writing the scratchpad the same rules apply as for the data field of a secure
Subkey. See section “Modifying Secure Data” for details. With the scratchpad,
however, the program accepts up to 64 bytes.
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EEPROM Viewer
The EEPROM Viewer provides a simple means to read and write the 256-bit Data
Memory and the 64-bit one-time programmable Application Register area of the
DS1971 (DS2430A) EEPROM iButton.

UDP stands for Universal Data Packet.  It is a simple format that protects a serial
data stream against transmission errors by cutting it into packets that each are
preceded by a length information (e. g., one byte) and followed by an inverted
CRC16 over the length byte and the data of the packet. With its 32 bytes of memory
capacity and the formatting overhead of three bytes the DS1971 (DS2430A) can
finally store 29 bytes of user data.  The Data Memory can also be edited as 32 bytes
of raw data.  Radio buttons on the left side of the Data Memory panel controls the
edit mode.

The Application Register can only be edited in ‘Raw’ format allowing you to alter all
64 bits (8 bytes) of data.

The edit window for the EEPROM Viewer is very similar to the File Editor Window of
the File Viewer with only the Text and Binary edit modes functional.

Reading Data Memory
No memory is read upon activation of the EEPROM Viewer.   For the Data Memory,
the edit mode must first be selected from the radio buttons and then the ‘Edit’ button
clicked to read.   If the UDP Packet radio button is selected it checks the data format
and displays the data content as ASCII text if it consists of text or as binary if 00
were detected. This works well if the device has been programmed in a previous
session of the UDP Packet editing. Since a fresh device contains a constant pattern
(typically 55 hex = 85 decimal) in every location, the format test will fail and the error
message “Could not read a valid UDP on this device !” will be displayed in a
separate window. In this case simply acknowledge the message by clicking “OK”.
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An empty packet to edit will then be displayed.   If a valid UDP Packet is detected
then the edit window is displayed with the packet contents.   If ‘Raw’ format is
selected then the entire 32 bytes of data is displayed for editing.  Note that the ‘Raw’
edit is less reliable because it does not contain CRC validation.  It is recommended
you use the UDP Packet when possible.  See the TMEX File Viewer description for
details on how to use the data edit window.

Reading Application Register
The Application Register can be read by clicking on the ‘Edit’ or ‘Read’ button in the
Application Register buttons.  The button says ‘Edit’ if the Application Register
contents are not yet locked.  It says ‘Read’ if the Application Register has been
locked and the contents can not be changed.

The Application Register can only be edited in a ‘Raw’ format fashion.  All 8 bytes
(64 bits) are available to edit.

Editing and Writing
When finished with editing the Data Memory or the Application Register the ‘Write’
button is used to transfer the changes to the DS1971.

The Application Register can be locked by clicking on the ‘Lock’ button in the
Application Register options.  The Register can only be clocked once so the
contents must be edited with care before locking.
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UDP Viewer
The UDP Viewer provides a simple means to read and write universal data packet.

UDP stands for Universal Data Packet.  It is a simple format that protects a serial
data stream against transmission errors by cutting it into packets that each are
preceded by a length information (e. g., one byte) and followed by an inverted
CRC16 over the length byte and the data of the packet. With its 128 bytes of
memory capacity and the formatting overhead of three bytes the DS1992 can store
125 bytes of user data.

The window of the UDP viewer (see below) has some similarity with the File Editor
Window of the File Viewer in text mode. The center of the window provides a large
area for reading/editing text. The lower part of the window displays the character
count of the data packet and its maximum size. The window is completed by a
Status Bar that indicates the communication port that is in use and a short Menu Bar
with the entries File (to exit the UDP Viewer) and View (to refresh the screen in order
to cancel edits that are not yet saved).

Reading Text
As the UPD Viewer is activated it automatically reads the main memory of the
selected device, checks the data format and displays the data content as ASCII text.
This works well if the device has been programmed in a previous session of the
UDP viewer. Since a fresh device contains a constant pattern (typically 55 hex = 85
decimal) in every location, the format test will fail and the error message “Could not
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read a valid UDP on this device !” will be displayed in a separate window. In this
case simply acknowledge the message by clicking “OK”. If a device has been
formatted by the File Viewer it will contain a valid data packet, but no text data.
Since the UDP viewer does not support editing binary data it will display the
message “WARNING, this record contains binary data. It may not display correctly in
this editor.” Simply acknowledge the warning.  The data displayed and the length
may be incorrect.

Editing And Writing Text
Once the text stored in the device is displayed, one can start typing new text if the
device is empty or modify existing text. To replace a word, double-click it and enter
new text. To replace a selection, select the text to be replace with the mouse and
type the new text. Alternatively, one can position the cursor anywhere in the data
field and start erasing or typing, whatever is necessary. The program counts the
characters and stops accepting more data as soon as the data field contains 29
characters. The current number of characters is displayed as “Record Size” below
the text reading/editing area.

As soon as the first modification is made, a button “Write UDP” will appear in the
lower right of the UDP Viewer window. To write the new text to the device, click this
button. To ignore the edits, exit the window of the UDP viewer or click on “Refresh”
in the view menu.
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Temperature Viewer
The Temperature Viewer was created to demonstrate the features of the DS1920
(DS18S20) Temperature iButton. The DS1920 (DS18S20) is a single-chip direct-to-
digital thermometer with 1-Wire interface and parasitic power supply. It directly
converts the temperature at the chip into a 9-bit digital reading in ° Celsius with a 0.5
°C resolution over a working temperature range from -55 to +100 °C (-67 to +212
°F). Access to counter registers of the temperature conversion logic allows the user
to increase the resolution of the temperature reading to 1/100 °C approximately,
depending on the actual temperature. To watch for extreme heat or cold the chip
includes two non-volatile trip point registers that store an upper and lower
temperature limit and are linked to the temperature converter by a comparison logic.
If the actual temperature gets outside the predefined range, this logic will make the
device respond to the conditional search command to signal an alarm.

The resources of the DS1920 (DS18S20) are laid-out in the window of the
Temperature Viewer as shown above. The temperature reading pictured as an
analog thermometer and as a digital display occupy the majority of the window. The
high and low trip points are displayed at the right side of the window. If the measured
temperature is outside the interval set by the two trip points, an alarm bell will be
visible above the digital temperature display. The window of the Temperature Viewer
is completed by a Status Bar that indicates the communication port in use and a
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short Menu Bar with the entries File (to exit the viewer) and Options (to change the
temperature scale).

Reading the Temperature
The temperature display is updated continuously. With every new temperature
conversion the color of the number in the digital display toggles between red and
black to make the new value distinguishable from the previous one. The temperature
viewer uses the contents of the counter registers of the conversion logic to
interpolate the reading to a resolution of 0.1 °C/F.

When a brand new DS1920 (DS18S20) is viewed, both trip points are likely to be at
32 °F (= 0 °C) and the alarm bell will be visible. For information on how to set the trip
pints, please see the next paragraph. Although the DS1920  (DS18S20) internally
operates in the °C scale, the Temperature Viewer uses the °F scale to display the
temperature reading and trip points whenever it sees a device for the first time. For
convenience, the temperature scale can easily be changed to °C and back to °F.
The program will remember the last setting when the same device is accessed later.
To change between scales, open the Options menu and click on the preferred scale.
Changing the scale automatically recalculates the actual temperature reading and
the trip points.

Changing The Trip Points
The trip point temperatures are stored in the device with a resolution of 1 °C. By
hardware design, changing the value of one trip point automatically re-writes the
other. To change the value of a trip point, click on the up or down arrow to the right
of the trip point display. A single click will increment or decrement the value by 1 °C.
Keeping the mouse button pressed will change the number repeatedly in the
direction of the arrow. Alternatively one can click on the value of the trip point and
use the cursor up/down keys to change the setting. The upper and lower limits for
the trip point setting are +100 °C (+212 °F) and -55°C (-67 °F) respectively. A few
seconds after the last change new values will be written to the device. The numbers
become black to indicate that they are identical to those stored in the device.

When using the °F scale the trip point value as selected on screen will be converted
and rounded to the nearest °C value before it is written to the device. When read
back, another conversion and rounding is performed. Since ± 1 °F is a smaller step
than the ± 1 °C that the device can handle, the value read back may actually be ± 1
°F off from the desired value.

The Temperature Viewer does not check if the values of the trip points define a true
interval. For proper functioning of the alarm signaling scheme the high trip point
must have a higher value than the low trip point. To identify alarms, the program
performs a Conditional Search on the DS1920 (DS18S20) being viewed. If the
device responds, the alarm bell will be displayed.
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Switch Viewer
The Switch Viewer was created to demonstrate the basic features of the
DS2406/DS2407 Dual-Channel Addressable Switch Plus Memory or the DS2409 1-
Wire Net Coupler. These devices have the following common features:

•  electronic on/off switch
•  activity sensor
•  level sensor

The switching and sensing functions are reflected in the window of the Switch
Viewer as shown below. The memory of the DS2406/DS2407 is accessed by means
of the File Viewer. It has the same size as with the DS1982 and is typically used to
store application specific data.

The Switch Viewer window has two identical working areas A and B for the
DS2406/DS2407 and ‘Main’ and ‘Auxiliary’ for the DS2409.  Each of these areas
represents one channel and has three tabs: Switch, Activity and Level. The window
is completed by a Status Bar that indicates the communication port in use and a
short Menu Bar with File (to exit the viewer) as its only entry. As the Switch Viewer is
started, the Switch tab is opened for both channels. The symbol of the switch in the
lower half of the tab shows the actual status of the switches. On power-up both
switches are in the open (off) state. Although the device can be programmed to
power-up with one or both switches on, this function is not supported in this version
of the Switch Viewer.
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To close the switch, click anywhere on the switch symbol. The picture will immedi-
ately change to a closed (on) switch. If a load is actually connected to the switch, it
will now be powered up. To open the switch again, click once more on the symbol
of the switch. With each click the symbol will toggle from closed to open or vice
versa and the load will be switched off or on. The switch remains in its current state
if the Switch Viewer is closed. If the data line is disconnected, all devices will return
to their power-on default setting as soon as communication on the 1-Wire bus
resumes.

The input (sensing) capabilities of the device are accessed through the tabs Activity
and Level. To change to these modes, click on the label of the tab. The picture
below shows an example where channel A (or Main) monitors activity and channel B
(or Aux) monitors the voltage level. For any sensing to function, the switch of the
sensing channel must be open.

Activity is defined as the transition of voltage from low to high or high to low. The
activity mode is most useful to monitor piezo sensors.  The activity tab has two
option settings, “Auto Clear” and “Sound on Activity”. Auto Clear, if checked, clears
the activity sensor so that it can capture the next transition. If checked, Sound on
Activity allows a short beep to be generated with every transition as long as the
activity is viewed. Whenever activity is detected, the lower half of the Activity tab
shows an alarm bell to optically signal activity. With Auto Clear set, the bell
disappears shortly after the activity was detected. If the bell remains visible, the
activity sensor is most likely stimulated repeatedly or the Auto Clear is not checked (
no “×“ in the box left to Auto Clear). Since the activity sensor cannot distinguish
between internally and externally induced transitions, activity will be signaled as one
changes from switch mode to activity mode if there is a load connected and the load
has been switched before.
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In the Level mode, a new sample of the logical level at the I/O channel is taken
whenever the device is accessed and displayed as HIGH or LOW in the lower half of
the Level tab. In contrast to Activity, which is sensitive to transitions, Level does not
catch instances where the voltage level deviates from its quiescent level for a short
moment only. In case one needs to see both, one may connect both channels
outside of the device and view the activity with one and the level with the other.

The DS2406/DS2407 is available as Dual Channel and as Single Channel version.
For the single channel version the window of the Switch Viewer includes channel A
only and therefore is only half the size. Everything else works the same.

Using the Switch Viewer with the DS2409
The Switch Viewer does not support “Auto Clear” on the activity latches with the
DS2409 1-Wire Net Coupler.  The only way to clear an activity is to change the state
of both switches to (off).  If both switches are already (off), then turn one (on) and
then (off).  This will clear the activity latches.   Also, the DS2409 cannot have both
Main and Auxiliary switches (on) simultaneously.  If one switch is turned (on) and the
other is already (on) then it will be switched to (off).
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Serial Number Viewer
The Serial Number viewer displays the unique serial number for a iButton or 1-Wire
device.  This viewer is the primary viewer for the DS1990A.  The Serial Number
viewer is also used for devices that are not currently supported with a device specific
viewer.

The serial number is displayed in three color coded segments.  The left (red) part is
the cyclic redundancy check ‘CRC’ that verifies the integrity of the number.  The
middle (white) part is the serial number the device was assigned.  The right (yellow)
part is the device family code.  The family code indicates to an application the
capabilities of the device.  This family code is used by this application to spawn the
appropriate viewer.
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Debug Viewer
The Debug Viewer can only be used if the ‘Debug Enable’ option in the main menu
is checked.  The Debug Viewer allows byte level examination of some 1-Wire
memory devices. A message ‘(DEBUG)’ will be displayed above the list of ROM
numbers to indicate ‘Debug’ mode is activated.

The contents of the memory pages will be color coded to indicate which bytes are
length, data and CRC values that conform to the UDP format (see Dallas
Semiconductor Application Note 114).  The following is a list of the supported color
codes in ‘Debug’ mode:

 (white on red) Length byte of Universal Data Packet (UDP)

 (yellow on navy) Printable CRC validated data

 (gray on purple) Non-printable CRC validated data

 (white on green) CRC byte of UDP

 (black on light blue) Data outside the UDP
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iButton Viewer Customization/Advanced Features
Re-sizing Windows
As any common Windows program, the iButton Viewer allows several device viewer
windows to be open at the same time. These windows are opened with a default
size and position on screen. Both the size and position can be modified to provide
more space for reading/editing files with the file viewer or UDP viewer, for example.
To store modified window size/or position, the option “Auto Save Size/Position” must
be checked.

1-Wire Net Port (Options Menu)
This function allows the user to dynamically change the 1-Wire Port that is monitored
by the iButton Viewer to open additional sessions on a second or third port. It does
not alter the default selection made during the TMEX installation. When activated, 1-
Wire Net Port will display a window that provides a list of the possible ports similar to
the port selection scheme used during the TMEX installation. A brief test is
performed on the selected port to verify that communication is possible. If one
changes the port the list of devices in the Network Listbox is cleared. If “Auto Viewer
Start” is enabled another viewer for each device discovered will be launched.

Auto Viewer Start (Options Menu)
If this option is checked the iButton Viewer will automatically launch the primary
viewer for each device discovered on the 1-Wire Net. For devices that have been
viewed before, the latest window size and position will be used if “Auto Save
Size/Position” is enabled. Otherwise the default window settings are applied. Auto
Viewer Start is convenient when preparing demonstrations. If “Auto Viewer Close” is
also checked, the primary viewer of arriving devices will automatically be opened in
a predefined position and size and disappear as the device departs from the 1-Wire
Net.

Auto Viewer Close (Options Menu)
If this option is checked the iButton Viewer will automatically close subsequently
started device viewers when the device has departed from the 1-Wire Net. This
option is normally used in conjunction with “Auto Viewer Start” to automatically start
and close the primary device viewer when communicating with a transient device.

Auto Save Size/Position (Options Menu)
This option is by default checked. When checked, the size and position of the
windows of the iButton Viewer and any subsequently started viewers together with
the ROM code of every device viewed will be saved automatically in the IBVIEW.INI
file (16-bit) or the registry (32-bit) and retrieved when the program is started again.
This feature is convenient if the pool of devices viewed is limited and one cannot or
does not want to use the default window sizes or positions. For each device the
window configuration is also saved, so that if, many buttons are tested with this
option enabled the IBVIEW.INI file (or registry) may grow substantially over time. To
reduce the file size if this option was enabled accidentally or if one is concerned
about decreasing system performance and/or disk space one may simply delete the
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IBVIEW.INI file or the applicable registry keys. The next time the iButton Viewer is
started, it will generate a new and short initialization file or new registry key without
reporting an error message.

File Auto Overdrive (Options Menu)
If this option is checked the file viewer will attempt to communicate at a faster
communication mode called Overdrive if the selected communication port and
iButton device supports it. Overdrive-capable iButtons include the DS1996, DS1995,
and DS1986. This option should be disabled if the length of the 1-Wire Net cable
exceeds 10 meters.  Refer to the introduction to review which adapters are capable
of overdrive.

Set Flex Speed (Options Menu)
If this option is checked, then the adapter, if it supports Flex Speed, will be set to
communicate to 1-Wire devices in Flex Speed.  Flex Speed optimizes 1-Wire timings
for 1-Wire communication across long lines.

Debug Enable (Options Menu)
The Debug Enable when checked will list an extra ‘Debug Viewer’ for some 1-Wire
memory devices.  The Debug Viewer permits raw examination and some write
capabilities to the memory area.

Notes
If the iButton Viewer is minimized, all open device viewer windows will disappear. To
keep device viewers visible as icons, reduce the window of the iButton Viewer as far
as possible but do not use the Windows minimize function.

On the iButton Viewer and on all device viewers there is a green “1-Wire Net
Activity” indicator. On the device viewers the activity indicator blinks while the
particular device is accessed. If the indicator does not blink at all, then some other
application has not released the 1-Wire Net. TMEX arbitrates the 1-Wire Net access
by different applications and thus prevents collision. If a program is not acting
correctly this error condition will persist.
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Appendix A – 1-Wire Net PC Adapters
The following table lists the 1-Wire Net PC Adapters available from Dallas
Semiconductor and third part suppliers that this version of the TMEX Runtime
Environment supports.

Data sheets and purchase information on these adapters can be found on Dallas
Semiconductor’s Web site: http://www.maxim-ic.com.

iButton specific information can be found on the iButton web site:
http://www.ibutton.com.

1-Wire Net PC Adapter Table
Part Number PC Port Extended Features
DS9097U-009
DS9097U-S09
DS1411

COM Overdrive, Power Delivery

DS9097E COM EPROM Programming
DS9097
DS1413

COM None

DS1410E LPT Overdrive, Power Delivery
DS1410D LPT None
DS9097U-25 COM Overdrive, Power Delivery,

EPROM Programming
DS1490F 2-in-1 Fob USB Overdrive, Power Delivery
DSXXXX
(future product)

USB Overdrive, Power Delivery,
EPROM Programming

Special Feature

Overdrive
Normal 1-Wire Net communication operates at 16.3K bits per second.  All iButtons
and 1-Wire devices that operate on the 1-Wire Net support this communication
speed.  Some of the new model devices now also support a faster communication
mode called ‘Overdrive’.  Overdrive mode boosts communication speed to 142K bits
per second.

Power Delivery
Most iButton and 1-Wire devices are parasite powered.  This means that they derive
their operating energy from the 1-Wire Net during communication.  Some devices
however require more energy then can be accumulated in this fashion. These
devices require an adapter that can provide extended power delivery on demand.

http://www.maxim-ic.com/
http://www.ibutton.com/
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Normally this is a mode in the adapter that switches on a stronger ‘pull-up’ to power
during the energy intensive operations.  Here are some devices that benefit from this
feature: DS1920 (temperature iButton), DS2450 (quad A/D), DS1954 (crypto
iButton), and DS2430A (EEPROM memory).

EPROM Programming
iButton and 1-Wire devices that are One-Time-Programmable (OTP) incorporate
technology called Electrically Programmable Read Only Memory (EPROM).
EPROM programming requires a special 12 Volt pulse to write data.  Although all of
the available adapters can read an EPROM iButton, only adapters with EPROM
programming capability can write to them.  Examples of EPROM based iButtons:
DS1982 (1K), DS1985 (16K), and DS1986 (64K).
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Appendix B – Installation Details

Self-Extracting Install
The install file downloaded from Dallas Semiconductor web site will be in the form of
a self-extracting single executable.  When run, this executable will extract the
standard install files into the Windows temporary directory and start the SETUP.EXE
program.  See the following section for details on the standard install files.

This installation comes with a means to uninstall TMEX as well.  To do this, simply
go to the Windows’ Control Panel and double-click on the “Add/Remove programs”
icon.  This will bring up a window that lists all the software applications currently
installed.  From this list, highlight the “iButton-TMEX (32-bit) V3.20” selection, and
then click on the “Add/Remove” button.  This will start the un-installation process.

General Information
TMEX Runtime Environment is a set of drivers used to facilitate communications
between TMEX applications and Dallas Semiconductor’s one wire devices. Included
in the Runtime Environment installation are the following:

iButton Viewer {32-Bit} - a Windows program for communicating with iButtons
and other 1-Wire Net compatible 1-Wire devices. The iButton Viewer supports a
true network environment. Device-specific viewers allow evaluation of special
function devices.

iButton Viewer Help {32-Bit} – a hyperlinked Windows help file that describes in
detail the full usage of the iButton viewer. This help file is also accessed through
the help system of the iButton Viewer.

Default 1-Wire Net {32-Bit} – a Windows program for selecting the default 1-
Wire Net port to be used by TMEX applications. Note that TMEX applications
such as the iButton Viewer, only use this default port on the first invocation.
Thereafter, they store their own current 1-Wire Net port. TMEX applications
without a means to select a new 1-Wire Net port, may rely chiefly on the default
port selected by this program.
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Drivers Installed
The following drivers are installed with this utility. The location to which the drivers
will be copied is described in the generic location specified by <>. This location is
system depended and will automatically be changed for your system.

General (TMEX)
Provides general-purpose access to all 1-Wire devices. The API is outlined in the
1-Wire SDK. This installation is a drivers-only version of the TMEX RTE (32-bit).

Drivers:
All Platforms

<windows\system>\ibfs32.dll
<windows\system>\ib97u32.dll
<windows\system>\ib97e32.dll
<windows\system>\ib10e32.dll

Windows 98, Windows 2000, Windows ME
<windows\system>\ib90usb.dll
<windows\system32\drivers\>ds2490.sys

Windows 95, Windows 98, Windows ME
<windows\system>\vsauthd.vxd

Windows NT, Windows 2000
<windows\system32\drivers\>ds1410d.sys

Windows 98, Windows ME
<windows\INF>\DS2490.inf
<windows\INF\Other>\Dallas Semiconductor Corp.DS2490.inf

Windows 2000
<windows\INF>\DS24902k.inf

Java
Provides native access 1-Wire drivers to Java. This library layers on top of the
‘General’ library detailed above. See the 1-Wire API for Java on this web site:
http://www.ibutton.com/software/1wire/1wire_api.html

Drivers:
<windows\system>\ibtmjava.dll

http://www.ibutton.com/software/1wire/1wire_api.html
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Java powered iButton
Provides the Java iButton Application Programmer Interface (JiB-API). See the
Java-Powered Cryptographic iButton here:
http://www.ibutton.com/ibuttons/java.html

Drivers:
<windows\system>\jibcomm.dll
<windows\system>\jibapi.dll

Registry Keys Added
The following is a list of registry keys added during this installation.

All Platforms
[HKEY_LOCAL_MACHINE\Software\Dallas Semiconductor]
[HKEY_LOCAL_MACHINE\Software\Dallas Semiconductor\1-Wire Drivers (Win32) V3.20]
[HKEY_LOCAL_MACHINE\Software\Dallas Semiconductor\1-Wire Drivers (Win32) V3.20\3.20]
[HKEY_LOCAL_MACHINE\Software\Dallas Semiconductor\iButton TMEX]
[HKEY_LOCAL_MACHINE\Software\Dallas Semiconductor\iButton TMEX\3.00]
"MainDriver"="IBFS32.DLL"
"TYPE1"="IB97E32.DLL"
"TYPE2"="IB10E32.DLL"
"TYPE5"="IB97U32.DLL"
"TYPE6"="IB90USB.DLL"

Windows NT, Windows 2000
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\DS1410D]
"ErrorControl"=dword:00000001
"Group"="Extended Base"
"Start"=dword:00000002
"Tag"=dword:00000002
"Type"=dword:00000001

Windows 98
[HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Setup\SetupX\INF\OEM Name]
"C:\\WINDOWS\\INF\\OTHER\\Dallas Semiconductor Corp.DS2490.inf"="DS2490.inf"
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Class\{36FC9E60-C465-11CF-8056-
444553540000}]
"Link"="USB"
"Class"="USB"
[HKEY_LOCAL_MACHINE\Enum\USB\VID_04FA&PID_2490]

Windows 2000
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Setup]
"SourcePath"="\\WINNT\\SYSTEM32\\drivers"

http://www.ibutton.com/ibuttons/java.html
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Dallas Semiconductor Corporation Assumes No Responsibility for the use of Any Circuitry Other than
Circuitry Embodied in a Dallas Semiconductor Product. No Other Circuit Patent Licenses Are Implied.
Information Contained Herein Supersedes Previously Published Specifications on these Devices from
Dallas Semiconductor.

MAXIM/DALLAS SEMICONDUCTOR CORPORATION October, 2001
4401 SOUTH BELTWOOD PARKWAY TMEX Runtime Environment 3.20
DALLAS, TEXAS 75244-3292
TEL: 972-371-6824
FAX: 972-371-3715
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